
THEOLT RELEASE 7
REFERENCE MANUAL



Copyright: Latimer CAD Limited 2004. Page: 2  Intentionally left blank



Page: 3 

TheoLt Release 7.0 User Guide Rev:1

Copyright: Latimer CAD Limited 2008. 

CONTENTS

Project Managment 1

Instrument Controls 5

Control (Orientation, Traverse) 11

Drawing 29

Viewing the drawing 38

Settings 40

Datafile Formats 61

Selecting and Adding stations 64

.



TheoLt Release 7.0 User Guide Rev:1

Copyright: Latimer CAD Limited 2008 Page: 4 



Page: 1 

TheoLt Release 7.0 User Guide Rev:1

Copyright: Latimer CAD Limited 2008. 

PROJECT MANAGEMENT

Background

During surveying, it is wise to produce a set of basic data files in addition to 
the AutoCAD drawing data. TheoLt stores these data files in project fold-
ers.

The current project is controlled by the [Project Manager], accessed on the 
[Project] tab. The name of the current project is displayed. Upon installa-
tion (or changing of the project path), a default project “Default” is created. 
This default project may not be deleted but may be used in the same way 
as any other project.

Note: TheoLt project folders do not affect the working of AutoCAD. Storing 
the drawing files within the TheoLT project folder is strongly recommended 
as it ensures that all of the data representing a particular survey is 
together.

Each project stores the following information:
•  Project Name
•  Project Description
•  Date Created
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•  Starting Station position number
•  Last used Station position number
•  A list of the station positions used within the project
•  A list of all the orientations carried out within the project
•  The position verification data for the project.
•  Optional; User formatted text datafile (s).
•  Optional; Unformatted raw instrument text datafile (s).

Note: When editing a project, the “Starting Station / Reference number may 
be set. This allows each project to use a set Station Position number range. 
For Example:
•  Project 1 may use Station Position numbers 100 onwards
•  Project 2 may use Station Position numbers 500 onwards

When TheoLt is first started, the project path is set to:
•  “My Documents\My TheoLt Projects”.

As this is stored in the user “My Documents” location, the projects are local to 
each user. See Application Settings for details on changing the project path.

See Also: Settings: Application (For project path)
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PROJECT MANAGER

Function: For controlling the management of projects within TheoLt

Use: Select the [Project Manager] Icon from the [Project] Tab. 

[New Project] Creates a new project.

Project details may be entered. Once set, the [Project Name] may not be 
altered as this is also the name of the folder which will contain the data. 
The [Stations] fields allows the prefix used for all Station names and the 
next Station Number to be controlled according to the project.  Likewise the 
point numbers. The [Description] and [Created by] fields offer documentary 
information only.

The [Project Datum] field (new for Release 7) sets a specific datum that 
is valid for TheoLt features only. (It has not effect on any other area of the 
system at this release.

[Edit Project] Opens the project dialog for editing.

[Use Current project] Sets the currently  highlighted project as the 
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current project.

[Delete Current project] Deletes the currently highlighted project. Note 
the folder containing the data and the data itself is not deleted.
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INSTRUMENT CONTROL

Function: The Instrument Control Panel provides access to the basic 
instrument control and settings.

The panel has 3 display sections:

•  The control area, featuring: the Target Height and Fire / Make Observation 
controls.

•  Filters: controlling the use of the observations
•  History: shows a “stack” of the last instrument observations.

Use: As soon as the Instrument Panel is displayed, TheoLt is ready to 
receive data from the instrument. 

To make a 3D full angles and distance  observation either select 
the [All] button or Press the “Fire” / “Rec” or “All” key on the 

instrument.

To make an angles only observation select the [Ang] button.

To make use of angle only measurements one of the angle only filters need 
to be selected.
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Target Height: A field is provided for entering a Target (or Pole) height. The 
last 10 used heights are stored for quick re-use. The image on shows a 
docked “History” Instrument Panel with the Target Height List. 

Any change in the Target Height List is not activated until the tick icon is 
pressed.

The Target Height may also be altered by typing in the field or using 
the on-screen number pad.

For information on docking the instrument panel, see Application Settings.
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The History Panel:

The History Panel shows all of the observations received from the instru-
ment. The last observation is shown at the top of the list. Each observation 
type is denoted by a symbol:

Distance Only 

Angle Only

Angle and Distance (3D)
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Filters:

The instrument filters allow specific observation types to be modified. The 2 
observation types that may be filtered are:
 •  Angle and Distance (3D Observation)
 •  Angle Only

Angle and Distance Filter: Project 3D Point to 2D Height: 
This allows all 3D observations to be converted to 2D as they are made 
(for example during the measurement of a building plan). The Height (Z 
Value) is changed to the entered height when working in the Draw Tab Only 
(Control Points should remain in 3D).

Angle and Distance Filter: Project 3D Point to Vertical Plane: 
This allows all 3D observations to be projected to a vertical plane defined 
by two points.

All observations are projected perpendicularly to the plane. (As opposed to 
Angle only Observations which are plotted at the intersection of the observa-
tion and the plane).
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The [Project to XY]: If selected, the plane may be projected to the X-Y world 
coordinate plane within AutoCAD. If de-selected, the points are plotted at the 
true 3D position on the plane. 

Angle Only Filter: Project Intersection with Vertical Plane: 
This allows all Angle Only observations to be intersected to a vertical plane 
defined by two points.

The [Project to XY]: If selected, the plane may be projected to the X-Y world 
coordinate plane within AutoCAD. If de-selected, the points are plotted at the 
true 3D position on the plane. 

Angle Only Filter: Remote Elevation:
For each Angle Only Observation, the vertical angle is used to calculate the 
Height (Z value) over the last full 3D (Angle and Distance) Point Observed. 

I.e. When a Angle Only observation is received, the X and Y values of the last 
Angle and Distance observation is taken in conjunction with the vertical angle  
of the new observation to plot a point directly over the Angle and Distance 
Point.

Angle Only Filter: Horizontal Offset:
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For each Angle Only Observation, the Horizontal angle is combined with the 
Distance and Vertical Angle measurements from the last full 3D (Angle and 
Distance) Point Observed. 

Angle Only Filter: H and V Angle Offset:
For each Angle Only Observation, the Horizontal and Vertical angles angle are 
combined with the Distance measurement from the last full 3D (Angle and 
Distance) Point Observed. 

See Also: Settings: Instrument . 
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CONTROL TAB

Orientation

Function: The Orientation Panel provides 3 methods for fixing the instru-
ment position and orientating the instrument to the drawing file. In addition, 
a Position Verification method is provided for cross checking the position 
and orientation at any time. Finally, in the Pro version Network Adjustment 
is available.

Use: Select the [Orientation] Icon from the [Control] Tab. 

Default Orientation: A method for positioning the instrument at an abribtary 
position. The zero angle on the instrument will coincide with the zero 
(easterly) direction in AutoCAD.

Orientation to Reference: A method for positioning the instrument over an 
existing control point within the drawing. The orientation is controlled by 
reference to a second control point within the drawing. 

Resection: A method for positioning the instrument at an unknown point 
within the drawing by referencing 2 or more control points The orientation is 
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DEFAULT ORIENTATION

Function: A method for positioning the instrument at an arbitrary position. 
The zero angle on the instrument will coincide with the zero (easterly) 
direction in AutoCAD

Use: Select the [Orientation] Icon from the [Control] Tab. Select the 
[Default Orientation] tab.

The position may be selected by:

Use the [Snap] button in the instrument position group and 
select the instrument position block within the CAD draw-

ing. The Easting, Northing and Height data will be displayed (correspond-
ing to the point’s X, Y and Z data). For use on Snap, see Selecting Points in 
AutoCAD 

Enter the E, N & H values manually.

Selecting the [Use Default Position] will reset the position to the pre-defined 
default position (set at 1000, 1000, 100 during installation).

Selecting the [Set Default Position] will set default position to the currently 
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entered values.
Enter the height of the instrument as set up over the point.

The [Orientate] button will set the TheoLt coordinate system to match the 
CAD drawing with the position and rotation of the instrument. A new Station 
Position Block will be inserted at the selected point and the drawing will be 
centred on this point.

After this, a request for the status of the station may  be prompted. The sta-
tion should be declared as fixed or unfixed. 

[Close] the dialog once completed.

See Also: Settings: Instrument . Settings: Application. Selecting Stations. 
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REFERENCE ORIENTATION

Function: A method for positioning the instrument at a precise location with-
in the drawing. The rotation angle on the instrument is matched to the draw-
ing by the use of a reference position within the drawing. 

Use: Select the [Orientation] Icon from the [Control] Tab. Select the 
[Reference Orientation] tab.

The position may be selected by:
Use the [Snap] button in the instrument position group and 
select the instrument position block within the CAD drawing. The 

Easting, Northing and Height data will be displayed (corresponding to the 
point’s X, Y and Z data). 

Use the [Select Station from List] button in the instrument 
position group and select the instrument position block from the 

displayed list. The Easting, Northing and Height data will be displayed.

When selecting a Station, the Station / Target height confirmation window is 
displayed. Two heights are shown; the last used height for the station (or the 
set-out height) and the current Target Height from the Instrument Control 
Panel. .
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Use the [Snap] button in the reference position group and 
select the reference position block within the CAD drawing. The 

Easting, Northing and Height data will be displayed (corresponding to the 
point’s X, Y and Z data).

Use the [Select Station from List] button in the reference 
position group and select the instrument position block from 

the displayed list. The Easting, Northing and Height data will be displayed. 

Sight the reference position using the instrument and make an observation 
[All]  or [Ang] the instrument data will be displayed.

The [All] button will make a full 3D Angle and Distance obser-
vation. The slope distance of the observation will be compared 

to the slope distance measured from the CAD drawing and the difference 
displayed. Likewise with the Height (Z) difference.

The [Ang] button will make a Angle observation only. No dis-
tance check will be possible. Taking an Angle Only observation 

will select the [Angle Only] option below.

Enter the height of the instrument as set up over the point.
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During Traverse operations, it is common to swap the position of the instru-
ment and a prism on a tripod. For this purpose the [Swap] button will swap 
the values within the Target and Instrument Height fields.

The [Orientate] button will set the TheoLt coordinate system to match the 
CAD drawing with the position and rotation of the instrument. The drawing 
will be centred on the new station location point. 

[Close] the dialog once completed. 

See Also: Settings: Instrument . Selecting Stations. 
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RESECTION 

Function: A method for calculating the instrument position using existing 
reference data.

Use: Select the [Orientation] Icon from the [Control] Tab. Select the 
[Resection] tab.

The command requires that Instrument Observations are matched to 
Reference positions in the drawing. The method is to pick a Reference 
position from the drawing and then make the corresponding observation 
with the instrument. Once a matching set has been collected, the next set 
can be started. The command requires 2 or more complete sets to calculate 
the instrument position. 

For Each Set: 
The reference position may be selected by use of the [Snap] 
button in the reference position group and select the reference 

position block within the CAD drawing. The Easting, Northing and Height 
data will be displayed (corresponding to the point’s X, Y and Z data).
 

Use the [Select Station from List] button in the instrument po-
sition group and select the instrument position block from the 
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displayed list. The Easting, Northing and Height data will be displayed.

Use the [Fire] button in the observation group to complete the 
observation to the matching item. The instrument data will be 
displayed.

Once a complete set is observed, the [Next] button is available to move to the 
next observation set.

Once 2 or more sets of observations have been collected, the [Calculate] but-
ton will become available.

Enter the height of the instrument as set up over the point.

The [Calculate] button will set the TheoLt coordinate system to match the 
CAD drawing with the position and rotation of the instrument. The drawing 
will be centred on the new station location point.

After this, a request for the status of the station may  be prompted. The station 
should be declared as fixed or unfixed. 

See Also: Settings: Instrument .Settings: Application. Selecting Stations. 
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POSITION VERIFICATION

Function: Used for cross checking the position and orientation of the 
instrument using known Reference or Station control blocks (at any time). 
Exporting the report allows a Quality Control document to be built.

Use: Select the [Orientation] Icon from the [Control] Tab. Select the 
[Position Verification] tab.

There are no settings to enter in this method. The current Station Position 
and Height is known. 

Observe any existing Reference Point or Station Point using 
the instrument. The instrument may be activated by TheoLt or 
from the Instrument. If required, the [Target Height] should be 
change within the [Instrument Control panel].

The observation will be checked against all known Reference Control Points 
(both Station and Reference) used within the Control Point database. Once 
the most likely control point is found, the Observation position will be com-
pared to this point and the differences displayed within the report. Should 
the distance between the observation and the known point be greater than 
then Maximum Distance Error defined within the Instrument Settings, the 
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distances will be displayed in red. If the distances are within the tolerance, 
then the distances will be displayed in green. 

The [Save] button will enable the table to be saved in the following formats
• Excel Spreadsheet.
• HTML Format
• Text File

The file is limited to project folder. 

The displayed dialog is identical to the standard system save-as dialog ex-
cept that:
• No sub-folders within the folder are listed.
• The Create Folder icon is disabled.
• The folder list menu is disabled.

See Also: Settings: Instrument .
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NETWORK ADJUSTMENT: PRO VERSION ONLY

Function:  A real-time network adjustment tool for EDM control survey.  The 
project database is built up of control stations that can be edited and used 
for 3D full least squares computation for adjusted control networks. The 
network data can be used directly in AutoCAD or processed off line. The 
net-adjusted control is ideal for establishing rigorous control for building or 
topographic survey.

Use: Select the [Orientation] Icon from the [Control] Tab. Select the [Net-
work Adjustment] tab .

On first opening this panel, if the status of any control stations has not been 
confirmed at time of insertion, prompts will be issued to confirm this. The 
station should be declared as fixed or unfixed. Fixed stations will not be 
adjusted by the Network Adjustment, unfixed ones will. 

The following applies to the control network:
•  There must be 2 fixed points in the network.
•  Observations must comprise angle and distance data.
•  Station names must not contain spaces
•  Face left and face right observations are accepted.
•  Multiple occupations are accepted.
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•  New instrument and target height data acceptable on re-occupation.
•  Resection points can be included.
•  The current AutoCAD drawing may be used to view the network 

diagram.
•  Stations cannot be removed from the network.

All Orientation and Control Point observations are automatically added to 
the control network. Any observations made whilst the panel is open are 
added to the network.

Observe any existing Reference Point or Station Point using 
the instrument. The instrument may be activated by TheoLt or 
from the Instrument. 

• If an observation is taken to an existing station a dialog will prompt to 
confirm the target height. 

• Should the instrument data not match a known station position, a warning 
dialog will be displayed asking if a new station should be set-out. 

• If the new station option is declined an observation error message will 
advise of the nearest station and the error.

Rounds of observations can be taken to stations in the network, face left 
and face right measurements are recorded; the condition of the each 
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observation is reported as delta dist and delta height in the error to setout 
column. Confirmation of the instrument and target heights is shown as a 
‘tool tip’ when the cursor is paused over the observation fields. 

The Network Adjustment table will build up the observation data and give an 
indication of the quality of the sighting to the stations by highlighting in red 
the observations that are out of tolerance.

Observations may be excluded from the net adjustment calculation using a 
double click on the tick symbol In the I/E (include /exclude) column, rejected 
observations are then marked with an x symbol.

[Save As] will the current view of the table as Excel, txt or HTML format in 
the project folder.

[View] will plot the observation lines of the network in the current drawing 
in a discrete layer.

[Calc] will perform a 3D least squares fit on the network. Reports on 
network precision and performance will be shown in the relevant columns. 
An incremental backup of the pre-calculated data is saved to the project 
folder on each use of the calc function.
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[Report] generates a text file of the current network data with results for 
cross checking.

[Apply] applies the corrections to the project and optionally adjusts the 
AutoCAD drawing:
• Create new project with results
• Adjust station positions in current project
• Adjust station positions and detail in current project

TheoLt Pro automates backup of both the computation and the drawing 
data. When the adjustment is applied pre and post adjustment drawing files 
are generated. 

1.Create new project with results

This option opens the New Project dialog to create a new project using the 
adjusted results: All of the stations are inserted into the new project with 
the status FIXED and therefore cannot be adjusted in the new project. This 
option is ideal for creating an adjusted network and then forwarding that 
network to be used by others for data collection.

Once created, the new project needs to be set as the current project for 
use. 
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• [Close] the orientation panel. 
• Select the [Project] tab. 
• Open the [Project Manager}. 
• Double-Click the new project in the list to activate.

2. Adjust station positions in current project.

Use this option to adjust the station positions in the current project and 
selected drawings: this option only moves the stations, other data collected 
from the stations is NOT adjusted. This option is based on the assumption 
that the work is for the production of a control drawing with stations only 
that is adjusted for subsequent re-occupation of the stations post- adjust-
ment for the recording of detail. 

The adjusted station positions can be applied to the current project and 
selected drawing files. 2 copies of each drawing are automatically made: 
pre -adjustment (for backup) and post-adjustment (with the adjusted 
stations). 

Before adjustment, the drawings to be adjusted should be saved.

Upon selecting this option, the Open window is shown. It is possible to 
select multiple drawing files for adjustment, use the [ctrl] key. 
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Click [OK] when selected.

The correction is applied to the stations but not the observation rays from 
the view function: the displacement from the insertion point of the station 
from the endpoints of the observation rays reveals the applied correction.

3.Adjust station positions and detail in current project

The adjusted station positions can be applied to the current project and 
selected drawing files.  This option functions as for option 2 but with the ad-
ditional benefit that data captured from each station is also adjusted.

See Also: Settings: Instrument . Settings: Application. .
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INSERTING  STATION AND REFERENCE POSITIONS

Select the [Control] Tab. 

To insert Station or Reference positions using the Instrument for posi-
tion:

Any instrument observation will prompt which type of position block to in-
sert.

If a target height is being used to insert the station (i.e. a Tripod or Detail 
Pole over the Station Position), the target height may be entered here. This 
target height is not carried forward into the instrument target height field.

After this, a request for the status of the station may  be prompted. The 
station should be declared as fixed or unfixed. 
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To insert Station or Reference positions manually,  using the mouse, 
AutoCAD or typed coordinates for position:

[Insert Station]: The station position block will be placed into AutoCAD, 
on the cursor ready for positioning. Use any AutoCAD method for 
selecting the position. 

[Insert Reference]: The reference position block will be placed into 
AutoCAD, on the cursor ready for positioning. Use any AutoCAD method 
for selecting the position. 

Valid Methods of positioning the blocks are any that could be used to complete 
(for example) the AutoCAD move command:
•  Use an object snap to an existing entity.
•  Place the block at any location.
•  Type a coordinate on the AutoCAD command line.

See Also: Settings: Instrument . Settings: AutoCAD 
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 DRAW TAB

Drawing Within AutoCAD

Function: The drawing panel provides many methods for transferring the 
instrument measurements to the CAD drawing

Use: Select the [Draw] Tab. 

The commands are provided by way of a “drop-down” list. The required action 
is selected from the list.

Transparent: Selecting this method transfers any instrument measurement 
direct to the AutoCAD command line as though it had been typed directly. 
Selecting this option allows the instrument observations to be used for any 
AutoCAD command that accepts a 3D coordinate as its input.

The typical use of this mode is use of the Line command. 

Also use this mode when using any TheoLt Building Survey comment.

Note: All coordinates are automatically prefixed with the NONE snap 
command ensuring that AutoCAD does not use any running object snaps to 
corrupt any measurement data. The * prefix is used to denote the World Co-
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ordinate system.

Drawing 3D Lines

Function: To use instrument data to draw 3D lines within the Drawing file. 

Use: Select the [3D Line] Option from the [Draw] Tab.

The lines are drawn on the selected 3D layer (see layer management):

Re-select the [3D Line] option to start a new line. 

Select the [Transparent] option to stop drawing.

For ease of use, the instrument should be set to:
• Display a visible pointer at the point of measurement. 
• Be set to contactless (non-prism) measurement mode. 

When the first point is observed, no noticeable action will take place in 
AutoCAD, but the observation will be listed in the Observation History Win-
dow. Each subsequent Observation will draw a line between the last 2 ob-
served points.



Page: 31 

TheoLt Release 7.0 User Guide Rev:1

Copyright: Latimer CAD Limited 2008. 

Enable the [2D Copy] to also create a 2D Line using the same data. Enabling 
this displays the [Height] field for the 2D Line. See creating a 2D Line.

See Also: Settings: Layers

Drawing 2D Lines

Function: To use instrument data to draw 2D lines within the Drawing file 
at a fixed height (Z-value). 

Use: Select the [2D Line] Option from the [Draw] Tab.

The lines are drawn on the selected 2D layer (see layer management):

Re-select the [2D Line] option to start a new line. 

Select the [Transparent] option to stop drawing.

For ease of use, the instrument should be set to:
• Display a visible pointer at the point of measurement. 
• Be set to contactless (non-prism) measurement mode. 

When the first point is observed, no noticeable action will take place in 
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AutoCAD, but the observation will be listed in the Observation History Win-
dow. Each subsequent Observation will draw a line between the last 2 ob-
served points.

See Also: Settings: Layers

Drawing 3D Polylines

Function: To use instrument data to draw 3D polylines within the Drawing 
file. 

Use: Select the [3D Polyline] Option from the [Draw] Tab.

The lines are drawn on the selected 3D layer (see layer management):

Re-select the [3D Polyline] option to start a new line. 

Select the [Transparent] option to stop drawing.

For ease of use, the instrument should be set to:
• Display a visible pointer at the point of measurement. 
• Be set to contactless (non-prisim) measurement mode. 
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When the first point is observed, the polyline command will start. Each ob-
servation will be listed in the Observation History Window and the point added 
to continue the Polyline. 

See Also: Settings: Layers

Drawing 2D Polylines

Function: To use instrument data to draw 2D polylines within the Drawing 
file. At fixed height (Z-value) 

Use: Select the [2D Polyline] Option from the [Draw] Tab.

The lines are drawn on the selected 2D layer (see layer management):

Re-select the [2D Polyline] option to start a new line. 

Select the [Transparent] option to stop drawing.

For ease of use, the instrument should be set to:
• Display a visible pointer at the point of measurement. 
• Be set to contactless (non-prisim) measurement mode. 
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When the first point is observed, the polyline command will start. Each ob-
servation will be listed in the Observation History Window and the point added 
to continue the Polyline. 

See Also: Settings: Layers

Drawing 3D Circles

Function: To use instrument data to draw a circle at any 3D position within 
the Drawing file. 

Use: Select the [3 pt Circle] Option from the [Draw] Tab.

The circles are drawn on the selected 3D layer (see layer management):

The command requires 3 points, selected in a clockwise direction (as for 
AutoCAD). The points may be anywhere in 3D space. 

When the first 2 points are observed, no noticeable action will take place in 
AutoCAD, but the observation will be listed in the Observation History Win-
dow. 
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When the 3rd point is collected, the plane for the Circle is calculated and the 
Circle drawn in 3D space within the drawing.

Note: A temporary UCS is created on which the Circle is drawn. Once drawn, 
the previous UCS is selected.

Select the [Transparent] option to stop drawing.

For ease of use, the instrument should be set to:
• Display a visible pointer at the point of measurement. 
• Be set to contactless (non-prisim) measurement mode. 

See Also: Settings: Layers

Drawing 3D Arcs

Function: To use instrument data to draw an arc at any 3D position within 
the Drawing file. 

Use: Select the [3pt Arc] Option from the [Draw] Tab.

The arcs are drawn on the selected 3D layer (see layer management):

The command requires 3 points, selected in a clockwise direction (as for 
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AutoCAD). The points may be anywhere in 3D space. 

When the first 2 points are observed, no noticeable action will take place in 
AutoCAD, but the observation will be listed in the Observation History Win-
dow. 

When the 3rd point is collected, the plane for the Arc is calculated and the Arc 
drawn in 3D space within the drawing.

Note: A temporary UCS is created on which the Arc is drawn. Once drawn, the 
previous UCS is selected.

Select the [Transparent] option to stop drawing.

For ease of use, the instrument should be set to:
• Display a visible pointer at the point of measurement. 
• Be set to contactless (non-prisim) measurement mode. 

See Also: Settings: Layers

Inserting Blocks

Function: To use instrument data to insert blocks at any 3D position within 
the Drawing file. 
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Use: Select the [Insert Block] Option from the [Draw] Tab.

The Blocks are drawn on the selected 3D layer (see layer management):

Select the Block to be inserted from the [Block List].

If the selected block has user attributes configured then the values of these 
attributes are automatically filled using appropriate data from the observa-
tion. See Understanding Block Insertions.

The block is inserted at zero rotation according to the current UCS.

Select the [Transparent] option to stop drawing.

For ease of use, the instrument should be set to:
• Display a visible pointer at the point of measurement. 
• Be set to contactless (non-prisim) measurement mode. 

See Also: Feature Library Settings: Layers. Settings: AutoCAD
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VIEW TAB

Function: The view tab provides fast  methods of controlling the view within 
AutoCAD 

Use: Select the [View] Tab. 

The command are:

[Plan World] : Same as AutoCAD plan command. Restores a top view 
and zoom extents.

[Centre Instrument in Window] : Keep the current view orientation, 
panning the view so that the current station position is centre of the 
display.

[View from Instrument to Last Point] : Uses the AutoCAD dview 
command to create a perspective view “looking” from the instrument 
position to the last taken observation.

[Section through Last Point] : Creates a view perpendicular to the line 
drawn along the last observation. The view is created from the “left” 
side of the observation line when looking from the instrument.
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[Display the Help file] : Displays this manual as a PDF file.
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SETTINGS TAB

Function: The settings panel provides direct access to the user defined datafile 
export. The systems settings are also accessed from this area.

Use: Select the [Settings] Tab. 

The Datafile:

The datafile referenced on this panel is a user configurable datafile which will 
contain selected data for each instrument observation received. The datafile 
will also include orientation information.

For details on configuring the datafile see [Settings: Datafile].

The check box enables or disables the writing of data to the datafile.

The datafile is limited to the current project folder. The name of the datafile is 
displayed. To change the datafile, select [Browse]. 

The displayed dialog is identical to the standard system save-as dialog except 
that:
• No sub-folders within the folder are listed.
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• The Create Folder icon is disabled.
• The folder list menu is disabled.

To access the TheoLt system settings, select the Settings Icon.

See Also: Settings: Datafile. Project Manager. Datafile Formats
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APPLICATION SETTINGS 

Settings File:  Affects commands: TheoLt 

TheoLt settings are stored in the file “TheoLt.ini”. As default, this is 
installed in the application folder (c:\program files\Latimer-cad\Theolt 
Rxx). To enable the easy switching of settings (between instruments or us-
ers) TheoLt enables the selection of the file to use.

Use the [Browse] button to select the “TheoLt.ini” used to  control the 
system.

Note: Changing this option requires TheoLt to be restarted before the new 
file takes effect.

Note: The settings file may also be specified at start-up using the shortcut 
options. See creating a custom start-up icon.

Blocks Location:  
Affects commands: Draw Tab: Insert Block. Draw Tab: Features 
Settings: Blocks

User defined blocks may be inserted into the drawing using drawing func-
tions. By fully defining a list of blocks, TheoLt can automatically complete 
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the data for any User Defined Attributes attached to these blocks. 

The first step is to correctly setup the folder to contain the blocks. The 
full path should not include any “space” characters. This path is set in the 
AutoCAD Settings Tab. Once set, any required blocks should be copied or 
moved to this folder. 

The default folder for this is c:\TheoBlocks

Use the [Browse] button to select the correct folder. Only folders are dis-
played in the subsequent dialog box.

Note: Changing this option requires TheoLt to be restarted before the new 
setting takes effect.

Working Folder:  Affects commands: TheoLt

Defines the folder used for temporary files. The default folder for this is c:\

Use the [Browse] button to select the correct folder. Only folders are dis-
played in the subsequent dialog box.

Note: Changing this option requires TheoLt to be restarted before the new 
setting takes effect.
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Project Base Path: 

Affects commands: Project Manager. All datafile operations.

Defines the folder used as the base path for the TheoLt projects. Each 
project is created as a sub-folder of this. The default folder for this is My 
Documents\My TheoLt projects

Use the [Browse] button to select the correct folder. Only folders are 
displayed in the subsequent dialog box.

Note: Changing this option requires TheoLt to be restarted before the new 
setting takes effect. If the path is changed, a new Default project is cre-
ated in the new path. The default project cannot be deleted.

License Manager:  Affects commands: TheoLt

Starts the License Manager application. See Authorisation in the User 
Guide.

Note: Changing licenses requires TheoLt to be restarted before the new 
licenses take effect. 

Allow Instrument Docking:  Affects commands: User Interface
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The TheoLt toolbar and the Instrument control toolbar may be “docked” to 
form a single dialog box. This function enables or disables the ability to dock 
the toolbars.

If enabled, to dock the toolbars:
•  Right-Click on the TheoLt Toolbar title area:
•  Select Dock / Undock.

Angle Display in DMS:  Affects commands: Instrument Control Panel Inter-
face, Datafile

When this option is selected, all angles are displayed using Degrees, 
Minutes, Seconds notation. When de-selected, angles are displayed in 
decimal degrees.

Start in Project Tab:  Affects commands: User Interface

When this option is selected, TheoLt will display the project Tab upon start 
up (after the Start up Dialog). When de-selected, if a Total Station type in-
strument is connected, the Control Tab is displayed, otherwise the Draw Tab 
is displayed.
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Show Startup Dialog:  Affects commands: TheoLt Startup

When this option is selected, the start-up dialog is displayed for the speci-
fied amount of time. This allows the instruments in use to be de-selected. If 
not selected TheoLt starts without showing the dialog.

Note: If using a Bluetooth connection to either of the instruments and the in-
strument is not available, there will be a pause as TheoLt tries to locate the 
instrument. Showing the start-up dialog enables this pause to be avoided.

Show Verify after Orient:  Affects commands: Orientation to Reference. 
Resection.

When this option is selected, upon the completion of an orientation, the 
Position Verify window will be displayed with the orientation observations 
listed . This enables the quality of the Orientation to be checked before con-
tinuing.

Set Station Status on Insert:  Affects commands: Control Tab: Insert Sta-
tion.  Resection. Default Orientation.

When this option is selected, when inserting a Control Block (Reference or 
Station), TheoLt will prompt for the status (Fixed or Un-fixed).
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This status is used by the Network Adjustment module (Pro version only). 
If this option is not set, the status will be requested upon opening the Net-
work Adjustment window.

Fixed stations will not be adjusted, unfixed ones will.
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AUTOCAD SETTINGS 

AutoCAD Version:  Affects commands: TheoLt 

Controls the method used to communicate with AutoCAD and also the com-
mand formats.

As AutoCAD versions have changed, subtle changes have been made to the 
command options and sequences. This option allows the correct version of 
AutoCAD to be picked.

Use the [List] button to select the version of AutoCAD in use.

Control Layer:  Affects commands:  All Station and Reference commands.

Blocks representing the station and reference positions are inserted on a 
specific layer. This layer may be selected.

Block Scale/Size:  Affects commands:  All Station and Reference com-
mands. All Block insertion commands

All blocks, when inserted, have a scale applied. This scale may be selected.
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INSTRUMENT SETTINGS 

Instrument Type:  Affects commands: TheoLt 

Controls the command interface used to communicate with the survey 
instrument and also the command formats.

Use the [List] button to select the version of instrument in use. If the 
actual instrument is not listed, contact your local support agent to check if 
the instrument is supported within another instrument family.

Serial Port:  Affects commands:  TheoLt

Select the Serial Port to be used to communicate with the instrument. Use 
the [...] to change the Serial Port settings.

Prism Constant:  Affects commands:  All measurements

The slope distance measured by the instrument is modified by this amount.

Maximum Error:  
Affects commands:  All Orientation . Position Verify Network Adjustment

During orientation commands, TheoLt performs checks between the 
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measurement and AutoCAD based data. If the difference between the checks 
are greater than the Maximum Error value, then a warning message is 
displayed.

The Maximum Error value also controls at which point an error distance 
in the Position Verification report is flagged in the colour red as opposed to 
green.

Next Point:  Affects commands:  All measurements, Datafile export. Draw 
Tab: Block insert.

Control the number to be allocated to point number field for the next 
measurement.

Maximum Height:  Affects commands:  All Orientation . 
Instrument Control Panel: Target Height.

During orientation commands, TheoLt checks that the value entered for the 
instrument and / or target height is valid. If the height is greater than the 
Maximum Height value, then a warning message is displayed.
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DATAFILE FORMAT SETTINGS 

Field Lists:  Affects commands:  Datafile (User Defined).

The format of the datafile may be specified.

Choose from the available fields, using the icons to add or remove fields 
 to / from the inserted list. The fields are inserted in the order of the list, from 
top to bottom.

[Add] the selected field from the available list to the inserted list.

[Remove] the selected field from the inserted list to the available 
list

[Up] Move the selected inserted field up the  list.

[Down] Move the selected inserted field down the  list.
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Field Separator:  Affects commands:  user datafile

Select the character which should be placed to separate the fields within the 
datafile.

Write Raw Datafile:  Affects commands:  Project File

In addition to the user defined datafile. All information received from the 
instrument may be written to a file. The data is written in exactly the format 
it is received (not formatted), before processing by TheoLt. Each line is 
prefixed by the date and time it was received.

The file is created in the current project folder. The name of the file is: raw 
instrument data.dat
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BLOCKS SETTINGS 

Block Lists:  Affects commands:  Drawing Tab: Block Insert

User defined blocks may be inserted into the drawing using Theolt. By fully 
defining a list of blocks, TheoLt can automatically complete the data for any 
User Defined Attributes attached to these blocks. 

The first step is to correctly setup the folder to contain the blocks. The 
full path should not include any “space” characters. This path is set in the 
AutoCAD Settings Tab. Once set, any required blocks should be copied or 
moved to this folder. See Application Settings: Block Folder.

[Add] To select a block to include in the list.

[Remove] Removes a block from the list. The block is not deleted from the 
folder.

[Edit] Opens the Field Mapping Editor that will allow fields to be selected for 
assigning to attributes. TheoLt needs no knowledge of the attribute names, 
only the order in which they are inserted into the block. 

Choose from the available fields, using the icons to add or remove fields to 
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/ from the inserted list. The fields are inserted in the order of the list, from 
top to bottom. This field order must match the order that the attributes were 
created within the block.

[Add] the selected field from the available list to the inserted list.

[Remove] the selected field from the inserted list to the available list

[Up] Move the selected inserted field up the  list.

[Down] Move the selected inserted field down the  list.
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LAYER SETTINGS 

Layer Lists:  Affects commands:  Drawing Tab: All Drawing commands

When using the TheoLt drawing commands, the entities are drawn on preset 
layers. Use this feature to set the layer names.

When drawing a suffix is added to the layer name within AutoCAD to denote 
the type of feature and / or how it was collected:
•  _ 2D is added to the layer name for entities drawn using the 2D options.
•  _ 3D is added to the layer name for entities drawn using the 3D options.
•  _ [Current Station Name] is added to all layers to denote the station from 

which the entity was collected.

For example, the layer Feature1, when used from station 134 to collect 2D 
items will be added into AutoCAD as Feature1 _ 2D _ STA134

[Add] To create a new layer in the list.

[Remove] Removes the selected layer from the list.

[Edit] Enables an existing layer name to be changed.
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Note: It is strongly recommended that where possible, TheoLt drawing tools 
are used in preference to the basic AutoCAD tools. The layer management 
built into TheoLt allows a great deal of control over the positioning of data 
and the possibility of correcting any errors that may occur in the field. Where 
possible, adhere to the following guidelines:

•  Establish a layer convention.
•  Draw each feature item on a separate layer.
•  Keep layer names consistent between drawings and projects.
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CONTOURS DATA CAPTURE 

Note: Only applicable when a TheoContour real-time license is available.

Captured Points Layer:  Affects commands:  Contour Tab: Draw point

When using the TheoLt contour point command, the entities are drawn on a 
preset layer. Use this feature to set the layer name.

Breakline Layer:  Affects commands:  Contour Tab: Draw breakline

When using the TheoLt breakline command, the entities are drawn on a 
preset layer. Use this feature to set the layer name.
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CONTOUR OUTPUT SETTINGS 

Note: Only applicable when a TheoContour real-time license is available.

Contour Lines Layer:  Affects commands: Contour Tab: Contour
Enter the name of the layer to be used for the Basic Contour lines. If the layer 
does not exist in the drawing file, it will be created. 

Index Contours Layer:  Affects commands: Contour Tab: Contour
Enter the name of the layer to be used for the Index Contour lines. If the layer 
does not exist in the drawing file, it will be created. 

Contour Lines Interval:  Affects commands: Contour Tab: Contour
Specifies the interval for the basic contour lines I.e. for a surface that ranges 
between the heights of 10M and 12M, setting the interval to 0.5 will create 
contour lines at heights of: 10, 10.5, 11, 11.5 and 12.

Index Contours Interval:  Affects commands: Contour Tab: Contour
Specifies the interval for the basic contour lines i.e. for a surface that ranges 
between the heights of 10M and 12M, setting the Index interval to 2 will create 
contour lines at heights of: 10.5, 11, 11.5  and Index Lines at 10 and 12. Usually 
the Index Interval is a multiple of the Interval.

Index Text Layer:  Affects commands: Contour Tab: Contour
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Enter the name of the layer to be used for text annotation of the Index lines. 
If the layer does not exist in the drawing file, it will be created. 

Line Smoothing: Affects commands: Contour Tab: Contour
The contour lines may be drawn as either: 
•  Straight Lines - each contour line is made of many single straight line 
segments. 
•  Straight Polylines - each contour line is a single polyline. 
•  Splined Polylines - each contour line is a single polyline with the spline 
option set. 

1: Splined Polyline

2: Straight Polyline

3: Straight Polyline
Selected 

4: Straight Line
Selected 
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MOTOR DRIVE SETTINGS 

Note: Only applicable when a TheoMotor license is available.

Target Colour:  Affects commands: Instrument Control
Controls the colour of the cross hair target drawn on the instrument motor 
control panel.

Background Colour:  Affects commands: Instrument Control
Controls the colour of the background behind the cross hair target drawn on 
the instrument motor control panel.

Slow Speed:  Affects commands: Instrument Control
The speed of the motor drive is specified by the rate at which the target 
point travels across a surface at the target distance. This option controls 
the minimum speed at which the target point travels. The target distance is 
updated each time an instrument observation is made.

Fast Speed:  Affects commands: Instrument Control
The speed of the motor drive is specified by the rate at which the target point 
travels across a surface at the target distance. This option controls the 
maximum speed at which the target point travels
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THEOLT DATAFILE FORMATS 

A typical project folder.
TheoLt automatically creates data files containing important information 
regarding the Station and Reference positions during operation. This section 
explains the files created and the format thereof.

In this section, the follow key is used:
STN = Station Name
ste = Easting of Station
stn = Northing of Station
sth = Height of Station
date = date
col = Height of instrument over station point
tht = Target Height
orn = Orientation (of Station relative AutoCAD North)
han = Horizontal angle for reference
rfe = Easting of Reference
rfn = Northing of Reference
rn = Height of Reference

Station orientations.dat:  Affects commands: All orientation commands.
This file is written to each time any type of orientation is performed.



TheoLt Release 7.0 User Guide Rev:1

Copyright: Latimer CAD Limited 2008 Page: 62 

A Typical file:
[Orientation]
STA384=1000.00000,1000.00000,100.00000,1.66000,90.00000,1001.00000,1000.00000,99.66000,11:12:15 20/09/2004
STA121 _ 1=1000.00000,1000.00000,100.00000,1.66000,45.00000,1001.00000,1000.00000,99.66000,11:13:19 20/09/2004
STA121 _ 2=1000.00000,1000.00000,100.00000,1.66000,45.00000,1001.00000,1000.00000,99.66000,11:14:10 20/09/2004
STA114=999.00000,1000.00000,99.66000,1.66000,45.00000,1000.00000,1000.00000,100.00000,11:15:00 20/09/2004
STA122=1000.00000,1000.00000,98.00000,1.66000,-0.00000,11:17:09 20/09/2004
STA123=1000.00000,1000.00000,100.00000,1.66000,0.00000,11:37:17 20/09/2004
STA124=1000.00000,1000.00000,100.00000,1.66000,0.00000,13:57:49 20/09/2004
STA126=1000.00000,1000.00000,100.00000,1.66000,0.00000,14:01:11 20/09/2004
STA134=1000.00000,1000.00000,100.00000,1.66000,0.00000,18:11:23 20/09/2004

Each line is written in the format:

STN=ste, stn, sth, col, orn, date (For default orientations).
STN=ste, stn, sth, col, orn, rfe, rfn, rfh, date (For all other )

Note: Do not manually edit this file. TheoLt uses this file internally.

station list.dat:  Affects commands: All station commands.
This file is written to each time an instrument or reference position is inserted 
into the drawing via an instrument observation and/or Reference or Station 
position is selected from the drawing.

A Typical file:
[Station Name]
Maximum=719
STA536=996.51818 996.51818 102.53424 20:14:43 17/02/2004
STA534=1000.00000 1000.00000 100.00000 20:06:46 17/02/2004
STA538=1004.75626 998.72556 102.53424 20:08:10 17/02/2004
STA541=1003.48182 996.51818 102.53424 21:29:52 17/02/2004
STA542=996.51818 996.51818 102.53424 21:29:40 17/02/2004
STA549=999.72002 1009.71967 104.33445 21:49:29 17/02/2004
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station list.dat:  Affects commands: All station commands.
This file is written to each time an instrument or reference position is inserted 
into the drawing via an instrument observation and/or Reference or Station 
position is selected from the drawing.

A Typical file:
[Station Name]
Maximum=719
STA536=996.51818 996.51818 102.53424 20:14:43 17/02/2004
STA534=1000.00000 1000.00000 100.00000 20:06:46 17/02/2004
STA538=1004.75626 998.72556 102.53424 20:08:10 17/02/2004
STA541=1003.48182 996.51818 102.53424 21:29:52 17/02/2004
STA542=996.51818 996.51818 102.53424 21:29:40 17/02/2004
STA549=999.72002 1009.71967 104.33445 21:49:29 17/02/2004
STA550=1006.98565 999.60227 102.20632 21:49:37 17/02/2004

STA554=1003.48182 996.51818 102.86824 19:39:22 18/02/2004

Each line is written in the format:

STN=ste stn sth date

Note: Do not manually edit this file. TheoLt uses this file internally.

posn verify.dat:  Affects commands: Position Verification.
This file is written to by the position verification command. This file is a binary 
format file and cannot be manually viewed. To view the Position Verification 
report in a external file, use the [Save] command in the [Position Verification] 
dialog.
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SELECTING STATIONS FROM LIST

Function: To select a Station or Reference position from the project as 
opposed to selecting from the drawing file.

Use: Select the [Pick from list] Option from any orientation 
command that shows the option.

[Insert Reference] Inserts the currently selected station as a reference 
block into the current AutoCAD drawing

[Insert Station] Inserts the currently selected station as a station 
block into the current AutoCAD drawing

[Add Station] Prompts the user for a new Station number. along 
with Easting, Northing and Height. Creates a new station in the 
project. Use the [Insert Station]  to insert the station into the cur-
rent AutoCADdrawing  after creating.

When selecting a Station, the Station / Target height confirmation window 
is displayed. Two heights are shown; the last used height for the station 
(or the set-out height) and the current Target Height from the Instrument 
Control Panel. 
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